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Introduction

I have taught many Vectorworks users who think that 2D is the easy part of 
Vectorworks and 3D only comes into play as an added luxury:

“I want to get 2D under my belt first, then look at 3D.”

This is a complete misunderstanding of the way that Vectorworks creates 
drawings. 3D is not a luxury, it is an intrinsic part of the modelling/drawing 
process.

If you use Vectorworks effectively, the 3D parts are easy to create, they 
will create your drawings, and when you update the model, it will be easy 
to update the plans, sections, and elevations.

Here is an example: you need to create a simple wall and elevate it. The 
wall needs to include a door and a window.

When you use 2D drawing methods you have to draw the wall and plan 
and you have to project the plan down to create the elevation. This is 
reasonably straightforward and quick. If you are used to drawing in 2D, 
you might use rectangles, copy, paste, guides, et cetera to draw this.
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If you draw the same project in 3D, the wall is quickly drawn. The door  
and window tools make inserting them a breeze. Instead of creating the 
plan and elevation directly you would use viewports to create the same 
drawing as the 2D one. The 3D is just as quick to create – it just uses 
different tools and techniques.

When the client requires a change to the drawings, the 2D drawings have 
to be changed in plan and elevation. In some cases this would be a 
complete redraw. This is a slow and inefficient way to make your changes.

The 3D on the other hand only needs to have the door or window moved, 
resized or their location changed. These changes are quick to make and can 
often be done on the Object Info palette. When the viewport is updated it 
will already reflect the new design.

This is a very simple example and as the projects get more complex, the 
time savings by using 3D become even greater. A major benefit of using 
the model to create the drawings is the reduction in errors.
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This sounds a lot like it’s only suitable for architectural work, what about 
planting and landscaping? Although the example above uses a simple wall 
example the same principles can be applied to planting and landscape. 
When you create a landscape plan with planting and 3D objects, the same 
concepts can be used.

When the plan is updated, the elevations and sections are be updated easily 
(by clicking on the update button).

This means that you can quickly change the plan and know that the 
changes will be reflected in the sections and elevations.

You may have heard a lot of talk about a concept called BIM (Building 
Information Modelling) and how only some special programs are able to 
use BIM. This is simply not true. Vectorworks is one of several programs 
that are capable of handling BIM. One of the main BIM principles is the 
sharing information. Building Information Modelling uses a combination 
of 2D, 3D, and information. If you draw your design using 2D techniques 
only, it will not contain the 3D parts needed for BIM. Only by drawing 
effectively in Vectorworks will you create the information BIM requires. 

In this manual we will look at a small garden project that can show both 
the architectural and landscaping uses and the advantages of working in 
this way.
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Basic Concept

This is the design we will be using to explain the concept of changing from 
a 2D drawing method to a 3D BIM method of drawing. It is a simple 
design that will require some foundations, a slab (or hardscape), walls, 
columns, and framing for the roof.

This project is so simple we could easily draw this in 2D to create a plan, 
roof plan, elevations, and sections. The symbol design will allow us to 
compare the 2D only method with the BIM concept. With the BIM 
concept, not only do we create plans, sections, and elevations, but we can 
also extract data from the model such as the volume of columns, the areas 
of walls, the volume of the slab, et cetera.

http://wp.me/p2BFhB-7xt
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Set Up The File

The project will be a lot easier to create if you spend a few minutes setting 
up the file first.

Document Settings

• Go to the Menu bar.

• Choose File > Document Settings > Units…

• Choose the appropriate units for your project. In this manual I am using
millimeters.

• Click on the OK button.
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Page Setup

• Go to the Menu bar.

• Choose File > Page Setup...

• Click on the Printer Setup… button.

• Choose your printer, your page size, and your scaling. In this image I’ve
chosen the scaling of 71% which will allow an A3 page to print as if it
was a reduced A2 size page.
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•	 Click on the OK button to return to the Page Setup dialog box.

•	 Click once again on the OK button to return to the drawing. 

•	 Double-click on the Snap to Grid button to set your snap and reference 
grid. I always use the same size grid regardless of the drawing that I am 
working on. This will allows me to use the grid as a reference so that I 
know how far or how close I am zoomed into the drawing.

•	 Click on the OK button to return to the drawing.
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•	 Right click on the drawing area and choose Active Layer Scale…

•	 Choose an appropriate scale for this project. I usually choose a scale 
which is the same as the output scale on my drawings. For example, if I 
want to print out my drawings at 1:50, I will set my active layer scale to 
1:50. The reason I do this is that it makes things like dimensions and text 
easier to control because they will be created at the right size for 
outputting.

•	 Click on the OK button to return to the drawing.
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Layer Setup

As we are going to create a 3D drawing it will be substantially easier if we 
create and set up our layers correctly for this project. This is one area 
where some users think that Vectorworks is too complex. If you find this 
area complex, then it will pay to spend some extra time understanding 
these concepts. Using layers correctly will really speed up your designs.

If you’re using Vectorworks Landmark, then use the standard simple 
settings. However, if you’re using Vectorworks Architect you will find it 
extremely useful to use stories, layers, and levels. Tying these concepts to 
your wall styles will dramatically improve your 3D modelling.

If you’re using Vectorworks Landmark, Spotlight, or Fundamentals, then 
follow the instructions for using standard simple Vectorworks settings. If 
using Vectorworks Architect then set up your file using stories, layers, and 
levels.

• Go to the View bar.

• Click on the Layers button to open the Organisation dialog box.
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•	 Right click on the design layer (Design Layer-1).

•	 Choose Edit…

•	 Name the layer to make it easy to understand what it is used for.

•	 Change the Layer Wall Height to suit the wall construction. In this case 
we are going to draw a lower wall that is 450 mm (18 “) high.

•	 Click on the OK button to return to the Organisation dialog box.

•	 If you’re using the standard simple settings, click on the OK button to 
close the Organisation dialog box to return back to your drawing.

•	 If you are using Vectorworks Architect Stories, click on the Stories tab. 

•	 Add a story for the project.
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•	 Edit the default levels to suit the construction of this project. I have 
chosen to use levels to control the bottom of the foundations, the top of 
the lower wall, the underside of beams, and the underside of my rafters. 

•	 You can edit these levels by selecting each level then clicking on the 
Edit Level… button

•	 If you are not familiar with how to change your story settings, then have 
a look at the manual (SST_1501 Stories, Layers, And Levels), which is 
all about setting up Stories, Layers, and Levels.

•	 Click on the OK button to return to the Organisation dialog box.

•	 Click on the OK button once more to close the Organisation dialog box 
to return back to your drawing.

•	 We can use our Layer Wall Height to control the height of walls, or if 
you are using the more complex system, you can use the top of wall 
level to control the height of the wall.

http://learn.archoncad.com/2015/01/21224/sst_1501-layers-levels-and-stories/
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Creating The Design

Drawing Walls

Many of our projects need walls. This is obvious for architects but many 
landscape projects also use walls as well. If we use the walls correctly we 
can get the 2D view of the project that we require, and we can also get the 
3D part of the wall with very little effort. In this manual we will not be 
using complex wall styles (although these make the 3D modelling even 
quicker).

We will start this project by drawing the walls. Some people use the 
rectangle tool for this, but the walls are quick to draw and they have the 
advantage of creating the 3D parts of the wall for the elevations and 
sections. There is only a very small amount of extra work to do to make the 
walls useful.

• Go to the Building Shell or Walls toolset.

• Click on the Wall tool. We will not be creating a wall style, but for
larger projects wall styles are incredibly useful. Because the wall styles
are a resource, they can be saved in your library which will allow you to
reuse them on other projects.

• Go to the Tool bar.

• Click on the Preferences button, the last button on the Tool bar.
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•	 Enter the Overall Thickness of the wall. 

•	 Click on the Edit Wall Attributes... button.

•	 Set all the attributes to use Class Style. The reason we want to use class 
style is so that we can easily control the line weight infill of the wall by 
its class and we will be able to change this on different viewports.
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Click on the OK button to return to the Wall Preferences dialog box.

•	 Click on the Insertion Options tab.
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•	 We have set the wall to use the graphic style of the class, this portion of 
the dialog box is where we tell Vectorworks what class to use for the 
wall.

•	 Click on the Class pop-up menu.

•	 Choose the option: New…

•	 Type in the name for the class for this wall.

•	 Choose the option at the bottom: Edit Properties After Creation. This 
option will open the Edit Classes dialog box so that we can set the fill, 
pen, and texture settings for the class.

•	

•	 Click on the OK button.  
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•	 Edit the fill, pen, and texture settings for this class.

•	 Click on the OK button to return to the Wall Preferences dialog box.  

•	 If you are using the simple Vectorworks settings, choose the Top Bound 
to be Layer Wall Height. This will connect the height of your wall to 
the Layer Wall Height. If you go back to your design layers and change 
the Layer Wall Height, the wall you draw will automatically change. 
This is an easy way of controlling the height of your walls.

•	 If you are using the Vectorworks Architect Stories and Levels, set the 
Top Bound to be the level that you have created for this purpose. It will 
then connect the height of your wall to this level and if you go back to 
your Stories and change the level elevation, the wall will automatically 
change its height. This is also an easy way of controlling the height of 
your walls.
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•	 Click on the OK button to close the dialog box.  

•	 Go to the Tool bar.

•	 Click on the mode to draw walls using the Polygon Mode.

•	 Go to the Tool bar.

•	 Click on the mode to draw walls using the Left Control Line Mode.

•	 Click once to start the wall.

•	 Move your cursor vertically up the screen by the required distance. For 
this example I am using a distance of 3500mm (12’). You can speed up 
the creation of this wall and improve your accuracy by using the 
Floating Data Bar.

•	 If you are using the Floating Data Bar hit the Enter key twice. This will 
create your wall and allow you move to the next corner of your plan. 

•	 If you are not using the Floating Data Bar click once.
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•	 Move your cursor horizontally across the screen by the required 
distance. For this example I’m using is distance of 4500 mm (14.5’). 

•	 If you are using the Floating Data Bar hit the Enter key twice. This will 
create your wall and allow you move to the next corner of your plan. 

•	 If you are not using the Floating Data Bar click once.

•	 Move your cursor down and use your smart cursor to line up with your 
start point. 

•	 Double-click to stop.



©Jonathan Pickup - http://learn.archoncad.com	
SHORT SHARP TRAINING  - Issue 1607

Page 22

•	 If you are using the simple Vectorworks settings, go to the Object Info 
palette and check the Top Bound, it should be set to the Layer Wall 
Height. 

•	 If you are using the Vectorworks Architect Stories and Levels, go to the 
Object Info palette and check the Top Bound. It should be set to the  
level that you have created for this purpose. 
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When you change to a 3D view you can see that the walls have been 
projected in 3D and they are now at the correct height.
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Columns

There is a tool that is specifically designed for drawing columns. This tool 
creates a 2D and a 3D portion of a column. Like the wall tool, it makes it 
quick to create these objects if you set the preferences correctly. 

• Go back to the Walls toolset.

• Click on the Column tool.

• Go to the Tool bar.

• Click on the Preferences button (the last button on the tool bar).

• Set the preferences so that the bottom of the column sits on the top of the
wall.
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•	 If you are using the Vectorworks Architect levels, you can set these 
levels so that the bottom of the column will sit automatically on the top 
of the walls and the top of the column will line up with the underside of 
the beam above.

•	 Move your cursor on top of the wall to place the column. You might 
notice that I’ve chosen the back corner. The insertion point of the 
column is the centre, and moving to the intersection of the two walls 
allows me to snap to the centre of these walls.

•	 Double-click to place a column.
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•	 You could carry on with placing individual columns, but it is much 
quicker to mirror the columns.

•	 With that column still selected go to the Basic toolset and click on the 
Mirror tool.

•	 Go to the Tool bar.

•	 Ensure that you have selected the Duplicate Mode option (the second 
one). 
Move your cursor to find the centre of the wall.

•	 Click once.
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•	 Move your cursor away from the wall, making sure that it is 
perpendicular to the wall.

•	 You will see a preview (ghost image) of the mirrored column.

•	 Click once more to confirm the mirror.
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•	 The next part is to mirror the two columns that are already created, but 
they both need to be selected. While still using the Mirror tool, you can 
use the Command key on a Macintosh or the alt key on a Windows 
machine to select objects. Because we already have one column selected, 
remember to use the shift key is well so that both columns end up 
selected.

•	 Move your cursor to find the centre of the middle wall.

•	 Click once.

•	 Move your cursor away from the wall, making sure that it is 
perpendicular to the wall.

•	 You will see a preview (ghost image) of the mirrored columns.



©Jonathan Pickup - http://learn.archoncad.com	
SHORT SHARP TRAINING  - Issue 1607

Page 29

•	 Click once more to confirm the mirror.
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Creating The Roof Framing

We have a tool that will allow us to create roof framing, it’s called the 
Framing Member. If you are using the Fundamentals workspace change 
back to your professional workspace where you will find the Framing 
Member Tool on the Detailing toolset.

Not only will this tool create a 2D and 3D version of a framing object, it 
can also be used to create a takeoff report. In other words, this is a BIM 
object that has 2D, 3D, and information attached to it.

• Go to the Detailing tool set.

• Click once on the Framing Member Tool.

• Go to the Tool bar.

• Click on the Preferences button (the last mode).

• Fill in the preferences for a substantial beam. In this case I am creating a
beam that is 150 mm wide (6 “) and 300 mm high (12 “).

• Set the Vertical Reference to Bottom. When you adjust the elevation of
this object it will be measured to the bottom of your framing member.

• Notice on these preferences that there is no opportunity to set the
elevation for the object. This will have to be done later.
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•	 Click once at the midpoint of one column. 

•	 Move your cursor to the midpoint of the column furthest away. 
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•	 Click once more.

•	 The framing member has been created, but as I noted earlier we have to 
adjust the elevation.

•	 Go to the Object Info palette.

•	 Type in the required elevation to the underside of your beam in the Z 
field.



©Jonathan Pickup - http://learn.archoncad.com	
SHORT SHARP TRAINING  - Issue 1607

Page 33

•	 This will lift the beam up to the required elevation.

•	 Remember to use your mirror tool to copy this beam to the other side.
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•	 Go to the Tool bar. 

•	 Click on the Preferences button again.

•	 Set the preferences to create a suitable rafter. In my case I have used a 
rafter size that is 45 mm wide (ex 2 “) and 190 mm high (ex 8 “).

•	 I find this rafter is easier to draw in a Top/Plan view.

•	 With the rafter selected, you can use your Move by Points tool to make 
multiple copies.

•	 Go to the Basic tool set.

•	 Choose the Move by Points Tool.

•	 Go to the Tool bar.

•	 Click on the second mode (Distribute mode). This mode allows you to 
choose the start and end point for your copying and Vectorworks will 
distribute the copies evenly.

•	 Enter the required number of duplicates.
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•	 Moved to the end of your rafter.

•	 Click once.

•	 Move down to the required position for the last rafter. In this case I have 
chosen to line up with the start of my rafter and the end of my beam.

•	 Click once more to finish.
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•	 It is a good idea to assign your walls, columns, beams, and rafters to the 
appropriate classes so that when you create drawings you can choose to 
hide some of these objects. While you’re assigning these objects to 
classes you could also use the classes to control their textures.
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Creating Drawings

Now that we have some of the information, we can create drawings using 
viewports and sheet layers to show the live elevation from our model. You 
do not have to wait until the model is complete before you create your 
drawings. 

Viewports let you take a view of the model and turn it into a 2D Drawing. 
For this project, we need to create a plan view, a front elevation, a side 
elevation, and an isometric view. You could create all of the viewports 
individually, but there is a quicker way. This command is not available in 
all versions of Vectorworks, so check your workspace for it.

• Go to the Menu bar.

• Choose View > Create Multiple Viewports… This command will
allow you to create all the required viewports with one command.

• Choose Third Angle Projection.

• Then choose Top, Front, and Right.

• Set the scale to an appropriate amount. For this project, and for the size
of my page 1:25 will be suitable. On other projects you will have to
choose the appropriate scale, but don’t worry if you choose the wrong
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scale, you will always be able to change it later.

•	 This command will create a New Sheet Layer and will place the new 
viewports on it.

•	 If you haven’t set the correct page size for your drawing, go to File on 
the Menu bar and choose Page Setup… If you’re used to creating your 
drawings in 2D, you will be familiar with this anyway. 

•	 Arrange the viewports on the page as you like. You can use your Drag-
A-Copy technique (dragging with the control or option key held down) 
to create any other viewports required. One of the powerful features of 
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viewports is the ability to choose which classes and layers you want to 
see in each viewport.

•	 In this example I will show you how to choose a viewport and turn off 
the classes that relate to the roof framing.

•	 Select the Plan viewport.

•	 Go to the Object Info pallete.

•	 Click on the Classes… button.

•	 This opens a dialog box where you can choose which classes you want 
to see in this particular viewport.

•	 Turn off the classes that relate to the roof framing (beams and rafters).
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•	 Click on the OK button to return to the drawing.

•	 You will notice that the roof framing is no longer visible on the Plan 
viewport

•	 You can also add annotations to the viewport, allowing you to add 
dimensions, notes, and drawing labels.

•	 Right click on the edge of a viewport.

•	 From the pop-up menu, choose Edit Annotations.
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•	 Add any of the required drawing labels, notes, or dimensions.
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Creating A Perspective View

You can use your 3D model to create as many plans, sections, elevations, 
and perspectives views that you require. To create a Perspective view it is 
easier if you use the Renderworks Camera tool to do it.

You might notice that I have changed to a Top/Plan view in order to place a 
camera. I find it easier to place the camera this way.

• Go to the Visualization tool set.

• Click on the Renderworks Camera Tool.

• Move your cursor into the drawing area.

• Click once for the camera location.

• Move your cursor into the design. This will be the centre of your camera
view.

• Click once more to finish.
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•	 The first time that you use the Renderworks Camera tool, the 
Preferences dialog box opens. You can change the settings on this, or 
you can just click OK and then change your settings on the Object Info 
palette.

•	 With the camera selected, go to View on the menu bar and choose 
Create Viewport…

•	 If your camera is selected when you do this, Vectorworks will use it to 
set the view of your viewport. It will also embed the camera into your 
viewport so it will disappear from the design layer.
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•	 Fill in the settings on the Create Viewport dialog box.

•	 Click on the OK button. 

•	 Your viewport will be placed on any selected sheet layer. If you have 
room on your current sheet layer you can place it there.
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•	 If the viewports need updating (they show a dashed red border),  you can 
use the  Update All Viewports command from the View menu to update 
them.
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This command will update all of the viewports in the entire file. If you 
have several rendered viewports, this command will take longer to finish.
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Creating A Title Block

Now that we have arranged the viewports on a sheet layer, we can add a 
title block. There are two tools that we can use for this: Sheet Border or 
VAA Title Block. If you are using the NZ/Aust version of Vectorworks, 
use the VAA Title Block. If you are using the international version of 
Vectorworks, use the Sheet Border tool. 

• Go to the Dims/Notes tool set.

• Click on the Sheet Border tool (VAA Title Block).

• Move to the center of the drawing area.

• Double click to place the Sheet Border.

• If you are using the VAA Title Block, go to the Object Info palette,
click on the Snap To Page Position button. This will snap the title block
to your page.

• The first time that you use the Sheet Border tool, it will open a dialog
box for you to choose the default title block symbol. The Sheet Border
uses a symbol to control the graphic style of the title block, and this
symbol can be edited to reflect the corporate identity of your company.

• Click on the symbol browser (the area on the right side of the dialog
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box) and choose the symbol that is closest to the design you require.

•	 Click on the OK button to finish placing your sheet border.

•	 After you placed your sheet border you can use the Object Info palette to 
control the width of the border, what the title block will show, and you 
can even hide the border so that you do not have the lines going around 
the drawing.

•	 You should notice that this has been a quick way to create drawings.

•	 If you save this file as a Template file or if you use Save As.. to save a 
copy of this file you will not need to recreate the viewports. All you need 
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to do is to change the design layer and when you update the viewports 
you will see your new design.
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Completing The Design

Although we have created much of the plan, it is not complete yet. One of 
the important aspects of this method of drawing is that you do not have to 
finish your design before you create the drawings. When you make changes 
in the design layer, the viewports will reflect them. So at any time you can 
print the sheet layer(s) and see the latest information.

Creating A Slab

• Change back to the design layer.

• Go to the Building Shell toolset and click on the Slab Tool.

• Go to the Tool bar.

• Click on the Polyline Mode.

• Go to the Tool bar.

• Click on the Preferences button.

• Click on the button: Edit Slab Attributes…
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•	 Set all the graphic options to use Class Style.

•	 Click on the OK button to return to the Slab Preferences dialog box. 

•	 Click on the Insertion Options tab.

•	 Fill in the options you require for the elevation of the slab and the class 
for it.
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•	 Click on the button: Save Preferences as Slab Style… This is the same 
process as saving a wall style. 

•	 Name the slab style and click on the OK button.

•	 Click on the OK button once more to close the Slab Preferences dialog 
box.

•	 Move to the first corner of your walls.
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•	 Click once.

•	 Move to the next corner of your walls.

•	 Click once more.

•	 Continue clicking at each corner of your walls until you return back to 
your start point.
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•	 Click once more at your start point to finish creating your slab.

•	 As the slab is the latest object created, it will be placed in front / on top 
of everything else.

•	 Right click on the slab.

•	 From the contextual menu choose: Send > Send to Back.
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•	 The slab should now appear behind the walls.
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Adding Additional Walls

I keep coming back to it, as one of the key features of this way of drawing 
is the ability to update the design layer and see the changes on the 
viewports. At this point you may have had a discussion with your client or 
you may have looked at the design so far, and you realise that in order to 
use this area effectively, some additional screen walls are required.

• Go to the Building Shell toolset.

• Click on the Wall tool.

• Go to the Tool bar.

• Click on the Preferences button.

• Set up a new wall that will function as a screen wall. In this case I have
created a wall 45 mm (1.5”) thick.

• I have also set this wall up so that it will sit directly on top of the lower
wall and finish at the underside of the beams above. You could save this
wall as a wall style which will allow you to use it on other projects.
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•	 Move to the midpoint of the first column. You might notice that I am 
using the top edge of the columns because they are easy to see and snap 
on to. 

•	 Click once.

•	 Move to the midpoint of the next column.
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•	 Double-click to create the wall. 

•	 Move to the midpoint of the next column.

•	 Click once more to start the next wall.

•	 Move to the midpoint of the next column.

•	 Double-click again to create the wall.

•	 Repeat this process to create the last wall.
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•	 Using what you have learned so far about the creation of walls and 
columns, create the additional screen walls and columns around the 
space.
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Adding Furniture

Vectorworks comes with several furniture objects that you could use to 
populate your design. For this example I am only going to place a table and 
chairs, but you may want to place other furniture objects such as base 
cabinets, utility cabinets, handrails, et cetera.

• Go to the Furn/Fixtures Tool set.

• Click on the Table and Chairs Tool.

• Go to the Tool bar.

• Click on the Preferences button.

• Fill in the preferences to suit the size of the table you require. You might
also notice that I have chosen specific classes for the table legs, chair
legs, tabletop, and chair seats. These classes are also used to control the
textures of the table and chairs.
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•	 The first click determines the centre of the object. 

•	 The next click determines its rotation. 
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Creating A Section

It is now time to complete the drawings. If you are used to a 2D only 
workflow, you may not be used to using viewports and sheet layers to 
create your drawings. We have already set up one sheet layer and created 
several viewports but these might not be enough to fully describe the 
project. In this case we may need to create more viewports such as a 
section or a construction detail. If you are used to working with layers and 
viewports, then you will already know that we need to annotate these 
viewports adding notes, labels, and dimensions.

A section viewport will create a live section through our model. This can 
be used to show a conceptual section showing all the materials merged 
together or it can show a more detailed section showing the components of 
our walls, slabs, and footings.

• An easy way to create the section viewport is to use the Clip Cube.

• Go to the Quick Preferences menu (the utility menu at the far right-
hand side of the tool bar).

• Choose the option Show Clip Cube. This will place a Preference for the
Clip Cube on the Quick Preferences bar, making it easy to activate and
deactivate.

• Change to a 3D view.

• Select all the walls, columns, and roof framing.

• Go to the Quick Preference bar.

http://wp.me/p2BFhB-7yl
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•	 Click on the Show Clip Cube preference to activate. If it is already 
activated clicking on it again will deactivate it.

•	 Go to the Basic tool palette.

•	 Click on the Selection tool.

•	 Move your cursor to the edge of the clip cube and click on it once to 
make it active.	

•	 Move your cursor to a face of the clip cube.

•	 Clicking again will highlight that face in red. 

•	 Click once on the face of the clip cube to move it.

•	 When you move your cursor, the face of the clip cube will move as well.



©Jonathan Pickup - http://learn.archoncad.com	
SHORT SHARP TRAINING  - Issue 1607

Page 65

•	 Click once more to finish moving the clip cube.

•	 Adjust the Clip Cube to show the section through the model that is 
required.

•	 Highlight the face of the clip cube for the required section, then right 
click. 

•	 From the bottom of the contextual menu choose Create Section 
Viewport…
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•	 Fill in the required details for your section viewport such as the name of 
the viewport, its number, the layers and classes required, et cetera.

•	 Click on the OK button to finish creating the viewport.

•	 Move the viewport to the required place on your sheet layer.
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Creating A Detail

Vectorworks has the ability to link viewports to detail references. This will 
allow you to create a detail reference in one location and link it to a 
viewport in a different location. When you update the 3D model the section 
will update, and the detail will also update.

• Zoom in to the section viewport.

• Draw a rounded rectangle over an area to define the detail location.

• Go to the Menu bar.

• Choose View > Create Detail Viewport…

• Fill in the details for the viewport.

• Click on the OK button to continue.



©Jonathan Pickup - http://learn.archoncad.com	
SHORT SHARP TRAINING  - Issue 1607

Page 68

•	 Arrange the detail on the sheet layer. If you have several details, you 
could use a separate sheet layer them. 

•	 You will notice that the detail reference shown in the section is 
connected to the detail number on your sheet layer. 

•	 If you move this detail to another sheet layer your detail reference in the 
section will update to show the new drawing and sheet number for the 
detail. This is a way of automatically linking your detail references to 
your detail viewports.
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Conclusion

There is no doubt in my mind that using a Building Information Modelling 
workflow is by far the most productive way of creating drawings. As you 
can see from this manual, there are several speed advantages in building 
the 3D model. Initially, you might find that it is slightly slower as you learn 
to use walls, doors, windows, slabs, and other BIM objects, but as you use 
these more often, you will speed up to the point that it is just as quick to 
draw these objects as it is to draw them any other way e.g. 2D objects like 
rectangles.

As mentioned previously, many of my clients think that drawing in 3D is 
some sort of a luxury. But the way I see it, as you create the plan of your 
objects, you’re also creating the elevations, sections, and visuals at the 
same time. So it really is a much quicker way of drawing. Even if you are 
extremely quick at drawing and you could draw the 2D plan and elevations 
with the same speed that I draw them, when it comes to changes the 2D 
method is not only slower but .. it is much more prone to mistakes and 
omissions. Using BIM techniques not only is quicker but it reduces 
mistakes in the drawings.

The example that I used was a simple project that could be applied to both 
architecture and landscape design. When the projects get more complex, 
then the productivity that you gained by using the BIM approach increases 
exponentially.

There are certainly areas where a lot of 2D work is involved, for example 
detailing, room interiors, et cetera. I do not expect you to draw these parts 
of the project as 3D models.

Jonathan Pickup

July 2016
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